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Introduction

This document provides instructions to configure  Application Integration Framework (AIF) for data
exchange using the BizTalk adapter. The document also provides a brief overview of AlF

AlIF enables companies to integrate Microsoft Dynamics AX and communicate with external business

processes and partners through the exchange of XML over various transport media. AlF enables both
business -to -business and application  -to-application integration scenarios. AlF provides a programming
model, tools , and infrastructure support for XML -based integration of application functionality and da ta

with Microsoft Dynamics AX. AlIF enables Microsoft Dynamics AX to expose its functionality via services
and documents based on the Windows Communication Foundation (WCF). AIF also enables Microsoft
Dynamics AX to consume functionality exposed by external applications through Web services.

Audience

This white paper is designed for BizTalk developers and  Microsoft Dynamics AX  system administrators
who are responsible for installing, configuring, and troubleshooting integration with external systems
using A IF.

Prerequisites
To benefit from this white paper, you should have knowledge inthe  following areas:

e Enterprise application integration (EAI), business -to -business (B2B) and application ~ -to-application
(A2A) concepts and technologies

e Microsoft Dynamics A X Application Integration Framework (AlF) setup and configuration

e Microsoft BizTalk Server 2006 R2 administration , including troubleshooting BizTalk application S.
e BizTalk Server application development

e  Microsoft Visual Studio 2005 .

e XML schema of the documents exchanged

You also need to have a test environment set up to follow the hands -on instructions. The test
environment is covered in a later section of this document.

For information about configuration and maintenance of AlF, see the Server and Database
Administration Guide . For information about AIF for software developers, see " Integrating Other
Applications with Microsoft Dynamics AX " inthe Microsoft Dynamics AX SDK Help

System requirements

Before installing the Microsoft Dynamics AX BizTalk Adapter, be sure that your system meets or
exceeds the minimum hardware and software requirements
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Overview of  Application Integration Frame work ( AlF )

AIF provides an extensible framework that allows you to expose  Microsoft Dynamics AX  business logic
or exchange data with other applications. In AIF, data is exchanged with external systems through

business logic exposed as services. This model provides the ability to expose any X++ classas a
service . This service can be called from X++ or from an external system. As part of this programming

model, a set of services is included with Microsoft Dynamics AX that is based on documents such as a

sale s order or a customer.

AIF enables the integration of Microsoft Dynamics AX through Web services, Microsoft Message
Queuing (MSMQ), the file system (using a directory) , or BizTalk Server as shown in the following
diagram.

Overview of AllEomponents

r

Appllcanon Mainframe System Tradingpartner
o

Client layer o] % 7 ,
AlE BizTalk
Servetayer adapter |

Asyncadapters

AIF(Mlcrosoft Dynamicé&Xservice$

BUSInesmgIC |ayer 4- Microsoft Dynamics ax

Figure 1. Overview of the AIF components.

With Microsoft Dynamics AX 2009, AIF introduces document services , a new abstraction for
encapsulating business logic. Document services can be consumed directly from within the Microsoft
Dynamics AX application ( X++) or be published for consumption by external service clients through
transport adapters or ~ WCF services.
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The following diagram  provides a high -level overview of the  AIF document services classes

Trading
partner's XML
format

Transformation
through external
application such
as BizTalk

fram the AifDocument class

XML message is passed info
the service class as a document
object (DO). The DO inherits

Microsoft Dynamics AX

XML message

Document
Service Class

Ax<Document>
Class

Ax<Table>
Classes

External
application

Figure 2.  Flow chart describing  Microsoft Dynam ics AX document services

The document services consist of three primary components:

1. Document service classes: In Microsoft Dynamics AX, document services enable you to
exchange data with external systems by sending and receiving data in XML documents. Th ese
documents represent  business objects such as a customer, a vendor, a sales order, and so on. The
AIF document services are designed to be extensible. Developers can create their own document

services with the AIF Document Service Wizard or customize th e services that ship with Microsoft
Dynamics AX.
You can use the document services to enable enterprise application integration scenarios with Web

services and avariety of transport s, including the following:
e File system

e  Microsoft Message Queuing (MSMQ)

e BizTalk Server

2. Axd <Document> classes (also known as Axd classes): The document service  classe s call
functionality in the Axd<Document> classes. The Axd<Document> classes contain the business
logic for modeled entities. For example, the AxdCustomer class contains the logic for creating,
updating, and deleting customers and related information.

3. Ax <Table> classes: The Axd<Document> classes use the Ax<Table> classes to manipulate
data in the database. The diagra m in the preceding section illustrates how the Axd<Document>
and Ax<Table> classes interact in a document exchange .

The Ax<Table> classes are a further abstraction of a table and encapsulate the business logic
associated with creation and modification of records in the database table.
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Terminology

This section explains the concepts used in the AIF. The AIF concepts may or may not match with the
description of similar concepts in other products such as BizTalk Server .

Term

Description

adapter

A software component that enables message exchange using a specific
transport . In AIF, an adapter means a transport adapter.

business document

An XML data representation of an integration interaction.

channel

A named entity used to specify where and how to send and receive
messages. A channel specifies an adapter with its associated

configuration information and transport address.

document services

In Microsoft Dynamics AX 2009, a new services model was introduced
in AIF. This model provides the ability to expos e any class as a service
that can be called from X++ or from an external system.

endpoint

A company or entity that participates in a business -to-business (B2B)
or application -to-application (A2A) data exchange. An endpoint can be
an in -house independent s ystem, in the case of A2A.

endpoint action policy

Determines which actions are valid for a particular endpoint. An action

is bound to an endpoint using an endpoint action policy.

gateway queue

Provide s temporary storage for documents while they wait for

processing. Inbound messages are placed in a gateway queue by an
inbound transport adapter. Outbound messages wait in a gateway

gueue until an outbound transport adapter picks it up for sending.

message

An individual unit of data transported between endpoint locations. A
message consists of a document plus a header containing information
about the transfer.

document class

An X++ class (prefixed with Axd) with methods that perform actions
on documents.

pipeline processor

The pipeline processor enables transformations of the

inbound/outbound XML before/after the Microsoft Dynamics AX

document class acts on the document. Components are provided in

the base Microsoft Dynamics AX system for data value substit ution
and XSLT document transformations.

Web services

A unit of application logic that provides data and services to other
applications that  clients invoke by using the  Simple Object Access
Protocol (SOAP) over the  Hypertext Transfer Protocol (HTTP).

Web services can perform functions ranging from simple requests to
complicated business processes.
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Inbound and outbound message exchange

This section describes processing flow for inbound and outbound messages.

Inbound message processing

An external system  sends a message through a transport adapter such as Microsoft Message Queuing
(MSMQ), the file system, or BizTalk Server adapter. The AlF gateway receive service polls for

messages and then brings them into the gateway queue. The AIF inbound processing se rvice takes the
messages from the gateway queue. Next, the business logic in the AIF document service processes

the message and interacts with the database. The response message is then placed in the gateway

gueue. The gateway send service sends the respon se message using an outbound transport adapter.

The following diagram shows a high level overview of the processing flow for an inbound message.

AlF
] MSMG . Microsoft
xil:lfl:;:::ss ~—»{ Filesystem » Gateway queue * tb?;;::llsaic] »  Dynamics AX
e BizTalk g database

Figure 3. The conceptual message path for an inbound message

Outbound message processing

The AIF outbound  processing service processes send requests using the document services and places

the outbound messages in the gateway queue. The AlIF gateway send service then reads the

messages from the gateway queue and sends them out using a transport adapter. These tr ansports
adapters include Microsoft Message Queuing (MSMQ), the file system, or BizTalk Server adapter. The

external system then receives the message from the appropriate transport. The following diagram

shows a high level overview of the processing flow f or an outbound message.
AlF
Microsaft Outbound MSMQ
] AIF service . ’ Client receives
Dynamics AX - y § processing ] G quELe File system | »
database (business logic) queus BizTalk ML message

Figure 4. The conceptual message path for an outbound message.
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Synchronous and asynchronous message processing

AIF supports both synchronous and asynchronous data exchange s. Both the synchronous and
asynchronous data exchange s have different requirements for installation and configuration.
Understanding the types of exchanges that are available allows you to better match the functionality

in AIF with your data transfer and infrastructure  requirements

Adapter -based exchange

Document ex changes that use transport adapters in Microsoft Dynamics AX do not require the
installation of Microsoft Internet Information Services (I1S). These include:

e Microsoft Message Queuing (MSMQ)
e  File system
e BizTalk Server

MSMQ and file system  transport adapters only support  the asynchronous mode of data exchange. T he
BizTalk adapter supports synchronous and asynchronous modes of data exchange

In the synchronous mode, BizTalk bypasses the gateway queue s and communicates directly with AIF.
Messages sent to AIF bypass the gateway queue s in AIF and go directly  to the document services .
Similarly, the responses from the services bypass the AIF gateway queues and go directly to BizTalk
Server . In this mode, BizTalk sends a message to AlF and waits to receive a response.

Inth e asynchronous mode, the communication between BizTalk and AlF is done through the gateway
gueues. Messages going into AlF are sent to the gateway queue in AIF. When the batch jobs run, AlF

retrieves the messages from the gatewa y queue. AIF placesr esponses to BizTalk Server inthe AIF
gateway queue. Inthis mode, BizTalk Server does not wait for a response from AlF. Therefore, t he
asynchronous mode require s you to set up and use correlation in BizT alk to relate a response with i ts

original message.

Web services -based exchange

You can use Web services for synchronous document exchanges. Web services require the installation
and configuration of IIS. The Microsoft Dynamics AX system administrator generates the Web services
from th e Microsoft Dynamics AX business logic so that developers with limited Web experience can
easily create their own Web services.

Performance considerations

Deciding w hen to use asynchronous or synchronous processing depends on your message volume and
parti cular data transfer scenarios. If you have a high volume of messages being exchanged between

AIF and BizTalk, you may want to implement your exchanges asynchronously. Asynchronous

exchanges provide more control (via batch jobs and other configurations ) over the load placed on
Microsoft Dynamics AX for processing documents. Synchronous exchanges place immediate load on
Microsoft Dynamics AX, thereby requiring more system resources. If you need an immediate response

from a user -initiated request, you may wan t to use the synchronous mode.

You need to carefully determine the workload generated by your integration activities and the

resulting load placed on the system. The performance considerations of integration using AlF are
beyond the scope of this document. For more information, see the Server and Database

Administration Guide . Microsoft Dynamics AX 2009 introduces a new batch framework. The batch
framework has been significantly enhanced to provide a truly asynchronous (non -interactive) server -
based batch processing environment that is also capable of processing multiple tasks within a job

across multiple Application Object Server (AOS) instances. The Microsoft Dynamics AX 2009 batch
framework provides the capability of server -bound batches without the need for an interactive client.

You can configure your AIF document exchange to take advantage of the parallelism offered by this
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new batc h framework. For more information on the batch framework, see the Microsoft Dynamics
AX 2009 Implementation Guide . For more information about configuration of batch jobs and parallel
processing of inbound messages, see  Server and Database Administration Guide

This document details how to set up and configure the AIF BizTalk ad apter for data exchange. For

more information on set up and configuration of MSMQ, file system, and Web services, see
iConfiguring document exchanges Seivérbnd Badabgsd Aeimisisiratiano p i c
Guide .

Scenario Walkthrough
This section details the document exchange between AlF and BizTalk Server using a synchronous
mode and an asynchronous mode. The walkthrough cover s two scenarios : creating a sales order in

AlF based on an XML document from BizTalk Server and sending a purchase order from AlF to BizTalk.

The following actions occur when you send an XML document from BizTalk to AIF to create a sales
order.

1. To represent another system, application or partner providing new sales, y ou place a sales order
in an inbound file folder. In general, the format of this sales order can be EDI or another non -AIF
format; for the purpose of this scenario it is an AlF sales or der (XML). This is a manual step in the
walkthrough. However, you may have an automated process placing the sales order in the
production environment. For more information on AIF messages and actions, see AIF messages
topic on MSDN.

2. BizTalk Server monitors the file folder and sends the sales order to AlF. In synchronous mode,
BizTalk Server will bypass the AlF gateway queues and go directly to the AIF document services.
In asynchronous mod e, BizTalk Server will communicate with the AIF gateway queues.

3. The Dynamics AX application processes the sales order and returns an entity key (sales order
number) to BizTalk . The BizTalk application then sends the entity key to the outbound file folder.

4. You test the sales order to confirm valid test results.
The following actions occur when you send a purchase order from AIF to BizTalk Server.

1. You post an open purchase order and then choose the option to send the purchase order
electronically.

2. AIF send s the purchase order to BizTalk Server. BizTalk Server places the purchase order in the
file folder that you configure d as the output folder.

3. You test the purchase order to confirm valid results.

The next sections of this white paper provide step -by-step instructions and code to configure and test
the document exchange. You can use this walkthrough to develop an understanding of how different

components interact in this process and test the results of the exchange. The objective of th is
document is limited to providing a hands -on experience with configuring the data exchange using the
BizTalk adapter.
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Before you begin
Consider the following points before you begin:

e  The test environment: This walkthrough uses the Dynamics AX 2009 Pr e-sales Demonstration
Toolkit that is available for download at PartnerSource . PartnerSource is a secure portal that is
available to pa rtners who focus on Microsoft Dynamics and related business products. This Pre-
sales Demonstration Toolkit includes two Virtual PC images. The firstimage, VPC 1, uses a server
name of AX -SRV-01 and the second image, VPC 2, uses a server name of AX -SRV-03. This
walkthrough uses VPC 2. However, i n order for you to follow the instructions in the walkthrough,
you need to download  andinstall VPC 1 and VPC 2 or have a similar test environment set up.

Note: If VPC 2 prompts you to reinstall Visual Studio, you w ill need to reinstall Visual Studio 2005
Professional edition on the image.

e Setting up your own test environment: If you create your own test environment for this
walkthrough, it should inc lude the following components. For installation instructions, see the

Microsoft Dynamics AX Installation Guide

¢ Microsoft Dynamics AX 2009 base components with Application Integration Framework (AIF) .

e Microsoft BizTalk Server 2006 R2, Standard or Enterprise  editi on.
e Microsoft Visual Studio 2005 Professional edition.
e AIF BizTalk adapter installed onthe BizTalk Server host.

e  Assumption: All the references to folder path and program navigation are based on the test
environment set up in VPC 2.

e LoginID: Youneedto knowthel ogin ID for various services, steps , or users. In some cases, you
will also need to know the password. The test environment uses contoso \ administrator as the
user ID for all of the following steps or services. The services or steps listed below are explained in

later sections.

e The domain administrator account and password.

e The domain account and password used for the Business Connector proxy account.

e The domain account used for Dynamics AX Object Server and BizTalk services.

e The domain account an d password for the Admin user in the Dynamics AX 2009 application.

Note: Using the same account for various services and users is a deviation from security best

practices and is done for ease of learning and troubleshooting. In a production environment, f  ollow

the documented best practices for Microsoft Dynamics AX, BizTalk Server , and Visual Studio.
e Navigation inWindows : Navigation to frequently mentioned tools and programs is as follows:

e BizTalk Server 2006 administrati on console: Start> All Programs > Microsoft BizTalk
Server 2006 > BizTalk Server Administration

e  Microsoft Dynamics AX 2009 configuration: ~ Start > Administrative Tools > Microsoft
Dynamics AX 2009 Configuration

e  Microsoft Dynamics AX 2009 server configuration:  Start > Administrative Tool s >
Microsoft Dynamics AX 2009 Server Configuration

e Viewing and managings ervices: Start > Administrative Tools > Services

e Event Viewer: Start > Administrative Tools > Event Viewer

e  Microsoft Dynamics AX 2009 client: Start > All Programs > Microsoft Dynamics AX 2009
> Microsoft Dynamics AX 2009
e Navigation in the Microsoft Dynamics AX client: Navigation to frequently mentioned tools and
forms is as follows:
12
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e AIF configuration:  Basic > Setup > Application Integration Framework

e AIF queue manager, exceptions , or document history: Basic > Periodic > Application
Integration Framework

e Batch jobs and tasks: Basic > Inquiries > Batch job
e Sales o rder: Accounts receivable > Common Forms > Sales Order Details

e Purchase order: Accounts payable> Places>P urchase Orders

Step - by - step instructions

You need to complete  a number of tasks  for successful processing and testing of document exchange
using the AIF adapter. Th  is walkthrough provides step  -by-step instructions for the f  ollowing tasks in
the following  sections.

Check prerequisites for the Microsoft Dynamics AX application

Set up the Business Connector proxy

Install the AIF BizTalk adapter

Set up AIF configuration for the BizTalk adapter

Build and deploy the Visual Studio project

Configure orchestration in BizTalk Server

Configure AIF batch job and tasks

Test the asynchronous orchestra tion

Test the synchronous orchestra tion

Test the orchestration to send purchase orders

Troubleshooting

Check prerequisites for the Microsoft Dynamics AX

application

The following prerequisites must be in place before undertaking the procedures in this white paper

For more information and step -by -step instructions, see  the Microsoft Dynamics AX Installation Guide
1. You must have Microsoft  Dynamics AX deployed and configured with the base and AlF

components. A base system includes a database, Application Object Server (AOS), application
files, and at least one client. The AOS server with AIF  installed is referredto here as the
application integration server.

You require a Microsoft Active Directory directory service configured in native mode. You will need
a domain account for the Business Connector proxy

Set up the Business Connector proxy.

13

CONFIGURING THE APPL ICATION INTEGRATION FRAMEWOR K (AIF) BIZTALK ADAP TER FOR DATA EXCHANG E


http://go.microsoft.com/fwlink/?LinkID=99623

Set up the Business Connector proxy

The Business Connector proxy is a Microsoft Windows domain account used by external applications to

connect to Microsoft Dynamics AX. The Busi noa-behalfCofnhect or proxy provides t
functionality for ext  ernal user connections. The Business Connector proxy account should not be set

up as a Microsoft Dynamics AX user a ccount. If you have already set up the Business Connector proxy

account, you do not need to set it up again.

Use the following steps to set up a Business Connector proxy:

1. Have the domain administrator create a unique user in Active Directory using the form at
domain \username . This domain account should have the following characteristics:

e The u ser cannot have the same name as an existing Microsoft Dynamics AX user.
e The p assword does not expire.
¢ No interactive logon rights are granted.

2. Associate the proxy acco  unt with Business Connector in Microsoft Dynamics AX. This step adds the
proxy account to the Microsoft Dynamics AX database. Storing the proxy account in the database
ensures that multiple AOS instances can use the same proxy account.

3. Launch the Microsoft  Dynamics AX Windows client.

4. Launchthe System service accounts form (Administration > Setup > Security > System
service accounts ).

5. Inthe Business Connector Proxy group , enter values for the following fields:
e Set Alias = Administrator
e Set Network domain = contoso.co m.

6. Click OK to save and close the form.

Install the AIF BizTalk adapter

Prerequisites  : The server where you install the AIF BizTalk adapter is called the application

integration gateway. The application integration gateway must have Microsoft BizTalk Server 2006 R2
installed and configured before you install the AIF BizTalk adapter. Although not a prerequisite for

installing the AIF BizTalk adapter, you will need Visual Studio 2005 to create a BizTalk application. You
caninstall BizTalk Server and Visual Studio onthe Application Object Server (AOS) server for
development purposes.  We recommend thaty ouinstall BizTalk Server on a dedicated server in the
production environment for improved performance . Ensure that you are logged on with an account

that is a member of the Administrators group on the computer on which you are running the setup.

For more information, see the Microsoft Dynamics AX Installation Guide

Use the following steps to install the AIF BizTalk adapter.
1. Launch the Microsoft Dynamics AX 2009 Setup program.
2. Step through the initial wizard pages.

3. Onthe Modify Microsoft Dynamics AX installation page, select Add or Modify components
Click Next .

4. Onthe Addor modify components page, s elect BizTalk Adapter . Click Next .
Note: These components are already installed on VPC 2. Therefore, if you are using VPC 2, your

options for the .NET Business Connector and BizTalk adapter will appear disabled.
5. Click Install

6. Click Finish when the installation is done.
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7. Now make sure that the AIF BizTalk adapter has been installed and configured successfully.

8. Launch the BizTalk Server 2006 administrationc onsole (Start > All Programs > Microsoft
BizTalk Server 2006 > BizTalk Server Administration ).

1. In the navigationtree inthe left pane,e xpand BizTalk Server 2006 Administration > BizTalk
Group > Platform Settings . Click Adapters .

2. Intheright pane, c onfirm thatthe  Microsoft Dynamics AX 2009 appears in the  Adapters
list and the value of the Is Configured fieldis Yes, asshowninthe following screen shot .

Set up AlF configuration for the BizTalk adapter

This section provides step  -by-step instruction for configuration of AlF for the BizTalk adapter.

Configure transport adapters
1. Launch the Microsoft Dynamics AX client.
2. Click Basic > Setup > Application Integration Framework > Transport adapters
3. Under the File menu, click New to create a new record.
4

In the Adapter class field , either select AifBiz TalkAdapter  from the list or enter
AifBizTalkAdapter . This form scan s for transport adapter class and present s you with a list. The
scanning process will take some time.

5. Check the Active box, as shown in the screen shot
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